
Experiment NB-4: Nerve Action 
Potentials and Synaptic Potentials
Background

The purpose of this experiment is to demonstrate the 
effect that electrical activity (action potentials) in a 
presynaptic cell has on the electrical activity (synaptic 
potentials) in a postsynaptic cell.

In this experiment, the same technique used to record 
the resting membrane potentials of frog muscle fibers is 
used to record the synaptic potentials from crayfish 
muscle fibers. Synaptic potentials will be recorded using 
the a microelectrode and an intracellular electrometer. 

At the same time, the same technique used to record 
compound action potentials from frog nerve is employed 
to record the action potentials of crayfish motor axons. 
These spontaneously generated action potentials will be 
recorded using a suction electrode and an extracellular 
amplifier.

Crayfish Slow Flexor Muscles
The abdomen of the crayfish consists of six segments, 

each having its own armor plating--a sturdy exoskeleton-
-that is hinged to the ones anterior and posterior to it. 
Inside each segment lies the nervous system and the 
muscles that control the bending of the hinge between 
the segments. The segments can move only in one 
dimension, to curl the tail under the thorax (this is called 
flexion) or straighten the tail out (extension). These 
movements are controlled by different sets of muscles: 
flexors and extensors. Fast movements, such as the tail 
flip used to escape from predators, is controlled by a 
massive set of muscle fibers whose contractions are 
very fast; these are the fast flexor muscles. The slower, 
postural adjustments that crayfish use to balance 
themselves are controlled by a smaller sheet of more 
slowly contracting muscle fibers; these are the slow 
flexor muscles. These slow flexors are located just 
inside the exoskeleton on the ventral surface, very close 
to the ventral nerve cord. By removing the exoskeleton 
and some overlying soft tissue, the superficial muscles 
and the nerves to them are exposed and readily 
recorded.

Crustacean muscles show many interesting differences 
from vertebrate muscle. In most vertebrate muscles, 
each fiber is innervated by only one motor neuron, and 
that connection is always excitatory. In crustaceans, a 
given muscle fiber may be innervated by as many as six 
motor neurons, and the synaptic connections may be 
either excitatory or inhibitory. A vertebrate muscle fiber 
usually generates a propagated action potential in 
response to a single action potential in its motor neuron; 
crustacean muscles, on the other hand, rarely produce 
action potentials. Instead, impulses from crustacean 

motor neurons produce decremented responses, 
excitatory and inhibitory junction potentials (EJPs or 
IJPs), that are identical in all respects to postsynaptic 
potentials in neurons. Thus, crustacean muscle provides 
good material to study integrative physiology, such as 
summation of synaptic potentials and facilitation.

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

C-STIM-BNC-P2 BNC-dual pinjack stimulator cable

Double male banana-female BNC adapter

Model 3000 AC/DC extracellular differential amplifier

Model 3000 input cable

Suction electrode

Audio monitor

BNC T-connector

Model 3100 Intracellular electrometer and headstage

Microelectrode holder (adapter)

Glass microelectrodes

Micromanipulator with base (2 each)

Faraday cage

Steel base plate floating on a bicycle inner tube.

Headstage tester (18 megohm resistor with clip)

Preparation dish

Dissection microscope and light source

Bath ground electrode with cable

Pasteur pipettes and bulbs

Assorted banana cables and alligator clips 

Crayfish 

Crayfish saline (See appendix)

Electrode filling solution (See appendix)

IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure NT-3-1 in the Tutorial chapter for the location 
of the USB port and the power socket on the IWX/214.

3 Check Figure NT-3-2 in the Tutorial chapter for a picture of 
the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 
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5 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the labeled socket on the rear of the IWX/214. Use the 
power switch to turn on the unit. Confirm that the red power 
light is on.

Start the Software
1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 
the Windows Start menu, move the cursor to All Programs 
and then to the listing for iWorx. Select LabScribe from the 
iWorx submenu. The LabScribe Main window will appear 
as the program opens.

2 On the Main window, pull down the Settings menu and 
select Load Group.

3 Locate the folder that contains the settings group, 
INBLMV1.iwxgrp. Select this group and click Open.

4 Pull down the Settings menu again. Select the Synap-
ticPotentials-A-NBK settings file.

5 LabScribe will appear on the computer screen as configured 
by the SynapticPotentials-A-NBK settings.

6 For your information, the settings used to configure the 
LabScribe software and the IWX/214 unit for this exper-
iment are listed in Table NB-4-1 on page NB-4-2. These 
settings are programmed on the Preferences Dialog 
window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

Model 3000 Amplifier and Audio Monitor Setup
1 Place the Model 3000 AC/DC extracellular amplifier (Figure 

NB-4-1 on page NB-4-2) inside the Faraday cage and its AC 
power supply on the bench outside the cage.

2 Place a T-connector (BNC) on the Channel 1 BNC 
Input of the IWX/214.

3 Use a BNC-BNC cable to connect the BNC output of the 
Model 3000 to an open end of the T-connector (BNC) on the 
Channel 1 BNC input of the IWX/214.

4 Attach the BNC connector on the input cable of the audio 
monitor to the remaining open end of the T-connector on 
Channel 1 BNC input of the IWX/214.

 Figure NB-4-1: The front panel of the Model 3000.

Warning: Before connecting the input cable to the probe 
input of the Model 3000, turn off the Model 3000 amplifier.

5 Locate the C-DB15-P3 input cable (Figure NB-4-2 on page 
NB-4-2) in the NBK/214 kit. Attach the DB15 connector on 
the end of the input cable to the DB-15 probe socket of the 
Model 3000 amplifier.

 Figure NB-4-2: The C-DB15-P3 recording cable.

6 Attach the three connectors of the suction electrode 
assembly to the matching connectors of the input cable so 
that:

• the recording electrode, which is the wire inside the lumen of 
the suction tubing, is connected to the black (+) connector.

• the indifferent (reference) electrode, which is the wire 
wrapped around the suction tubing down to the glass micro-
electrode tip, is connected to white (-) connector.

• the ground electrode, that is in the solution in the bath 
chamber, is connected to the green (driven shield) connector.

7 Place the barrel of the suction electrode on a micromanipu-
lator placed close the crayfish preparation dish.

8 Place the knobs and switches on the front of the Model 
3000 amplifier in positions that configure the amplifier for 
this experiment. The settings used on the Model 3000 for 
this experiment are listed in Table NB-4-2 on page NB-4-3.

9 Plug the output of the AC power supply into the power input 

Table NB-4-1: Settings on the Channel Window 
of the Preferences Dialog Used to Configure the 
iWorx Recording System for Experiment NB-4.

Parameter Uni ts/Ti t le Sett ing Mode/
Function

Acquis i t ion Mode Scope Mult ip le

Sweeps Number 1

Delay between 
Sweeps Sec 0.000

Start User

Stop Sec Timed -  1.000

Display Time Sec 1.000

Speed Samples/Sec 10000

Channel  A1 Nerve AP S BNC

Channel  A2 Synapt ic Potent ia ls S BNC
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on the back of the Model 3000 amplifier. Plug the power 
cord of the AC power supply into the electrical outlet. 

10 Flip the power switch of the Model 3000 to the ON position 
and allow the amplifier to warm up for 5 minutes. 

Note: The filter settings listed in this table are suggested for 
use in ideal recording conditions. If noise is present in the 
recording environment, the high and low pass filters can be set 
at different levels to create a recording with less noise. If noise 
is caused by AC line voltage used to power the equipment in 
the lab, the notch filter can be used.

Model 3100 Amplifier Setup
1 Place the Model 3100 AC/DC extracellular amplifier inside 

the Faraday cage and its AC power supply on the bench 
outside the cage.

Warning: Before connecting the head stage to the probe 
input of the Model 3100, turn off the Model 3100 amplifier.

2 Connect the BNC output of the Model 3100 to the Channel 
2 BNC input of the IWX/214 with a BNC-BNC cable.

3 Locate the headstage probe in the NBK/214 kit. Attach the 
connector on the cable of the probe into the Mini-DIN6 
probe socket of the Model 3100 amplifier.

4 Mount the intracellular probe in the micromanipulator and 
place it near the dissection microscope and the preparation 
dish.

5 Place the knobs and switches on the front of the Model 
3100 amplifier in positions that configure the amplifier for 
this experiment. The settings used on the Model 3100 for 
this experiment are listed in Table NB-4-3 on page NB-4-3.

6 Position the preparation dish on the microscope stage, so 
that the center of the dish is visible through the microscope. 
Orient the light so that it shines on the center of the dish.

7 Plug the output of the AC power supply into the power input 
on the back of the Model 3100 amplifier. Plug the power 
cord of the AC power supply into the electrical outlet.

8 Flip the power switch of the Model 3100 to the ON position 
and allow the amplifier to warm up for 5 minutes. 

 Figure NB-4-3: The head stage of the Model 3100 electrometer.

 Figure NB-4-4: The front panel of the Model 3100.

Table NB-4-2: Settings on the Model 3000 
Amplif ier for Recording Motor Nerve Potentials.

Funct ion Sett ing

HIGH PASS FILTER (Hz) 100

NOTCH FILTER OFF

LOW PASS FILTER (kHz) 10

CAPACITANCE COMPENSATION Counterclockwise

COARSE DC OFFSET Midrange

FINE DC OFFSET Midrange

DC OFFSET OFF

INPUT MODE DIFF

GAIN 100

RESISTANCE (Ω )  TEST OFF

MODE REC

Table NB-4-3: Settings on the Model 3100 
Amplif ier for Recording Synaptic Potentials

Funct ion Sett ing

CURRENT COMPENSATION DC BAL Counterclockwise

CURRENT COMP. TRANSIENTS (2) Counterclockwise

CURRENT COMPENSATION SWITCH OFF

DC OFFSET Counterclockwise

DC OFFSET SWITCH OFF

CAPACITY COMPENSATION Counterclockwise

∆A Counterclockwise

RESISTANCE (Ω )  TEST OFF

NOTCH FILTER OFF

LOW PASS FILTER (kHz) 10

CURRENT INJECTION LEVEL (µA) Counterclockwise

CURRENT INJECTION SWITCH OFF

OUTPUT X1
iWorx Neurobiology Lab Manual NB-4-3



Note: The settings listed in this table are suggested for use in 
ideal recording conditions. If noise is present in the recording 
environment, the notch filter may need to be used to block 
noise is caused by AC line voltage used to power the 
equipment in the lab.

Headstage Probe Test

Warning: Before testing the head stage probe, turn off the 
Model 3100 amplifier.

1 Obtain a 18 megohm resistor (1/4 watt) with an alligator clip 
attached to one end and a banana jack on the other end.

2 Place a pin in the socket on the end of the headstage. 
Fasten the alligator clip on the end of the resistor to the pin 
in the socket of the head stage. 

Warning: Make sure nothing touches the gold ring around 
the probe input or the body of the head stage

3 Connect the banana jack on the other end of the resistor to 
the ground (GND) input on the front of the Model 3100 
amplifier with a male banana-banana cable.

4 Type Probe Test in the Mark box to the right of the Mark 
button.

5 Click Record and press the Enter key on the keyboard. 
The trace should appear near the center of the screen.

6 Locate the ΩTEST switch on the front of the Model 3100 
amplifier. Flip up the switch for a few seconds. The trace on 
the computer screen should deflect to a higher amplitude 
and return to the baseline when the switch is returned to the 
OFF position. Click Stop to halt recording.

7 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

8 Click the Double Cursor icon (Figure NB-4-5 on page NB-
4-4), so that two blue vertical lines appear over the 
recording window.

9 Click and drag one cursor to the baseline prior to the 
electrode test being run. Place the second cursor on the 
plateau recorded while the test was running.

 Figure NB-4-5: The LabScribe toolbar.

10 On the upper right margin on the Membrane Potential 
channel, the voltage difference between the positions of the 
two cursors, V2-V1, is the output of the Model 3100 and its 
probe. The output of the electrometer is 10mV for every 
megohm of load applied 

11 If an 18 megohm resistor is used to test the probe and the 
1X output of the Model 3100 is recorded, the output of the 
Model 3100 during the test is 180 millivolts (mV):

18 megohm x 10mV/megohm = 180 mV

If an 18 megohm resistor is used to test the probe and the 
10X output of the Model 3100 is recorded, the output of the 
Model 3100 during the test is 1800 millivolts (mV)

(18 megohm) (10mV/megohm) (10X gain) = 1800 mV

12 If the probe and amplifier test to the level that is appropriate 
for the gain of the unit, the probe, the electrometer, and the 
recording unit are working properly.

Electrical Noise 
Electrical noise is the most common problem 

associated with the recording of bioelectric signals. It 
radiates through the air and comes from electrical 
devices in the lab room or building: lights, power outlets, 
computers, monitors, and the power supplies. Since the 
source of power for these devices is 60Hz alternating 
current (AC), this electrical noise appears as a distorted 
sine wave with a repeating period of 16.7 milliseconds 
(msec).

There are two major sources of electrical noise: 
pickup and ground loops.

Pickup
Pickup is caused by electrical radiation that produces 

currents in the electrodes and wires leading to the ampli-
fiers in the recording system. Because the resistance in 
the electrodes is high, small currents produce large 
voltages that may be greater than the biopotential being 
recorded. The major ways to reduce pickup are:

• Faraday Cage: Put a grounded, screened enclosure, known 
as a Faraday cage, around the preparation and the electrodes. 
the enclosure separates the source of the radiation from the 
electrodes. The person operating the equipment might also be 
a source of noise, and he or she may need to be grounded.

• Shielded Cables: Use shielded cables to carry the signals 
from the electrodes to the amplifier and the recorder; this puts 
a protective ground around the wires carrying the bioelectric 
signal. 

• Differential Recording: Record using both a positive and a 
negative recording electrode placed on the nerve. The noise 
signals that are equal in magnitude, but opposite in polarity, will 
cancel each other out and leave a flat baseline. 

• Short Cables: Use the shortest cables available to reduce 
the length of wiring exposed to electrical noise.
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• Direct Current Equipment: Use equipment, like preampli-
fiers and illuminators, that are powered by batteries or direct 
current (DC) transformers.

• Equipment Removal: Unplug or remove unused alternating 
current (AC) equipment from the area.

Ground Loops
Ground loops are a troublesome source of electrical 

noise caused by the ground cable itself serving as an 
antenna for the noise radiating in the room. Using a 
Faraday cage to shield the preparation and the recording 
electrodes does not remove the electrical noise caused 
by ground loops. To avoid ground loops, use the 
following techniques:

• Ground Hub: Ground all the equipment around the prepa-
ration to a common grounding point (hub). This includes all the 
items that are electrically powered or are made of metal, like 
illuminators or microscopes. Use simple cables, like banana 
cords equipped with alligator clips, to connect each device 
directly to the common grounding point. The common ground 
point is connected to the ground of the recording device with a 
single cable. The recording device is connected to the building 
ground.

• Simple Chain: Ground the devices to the common 
grounding point using the simplest route that links the first 
device to the second device, the second device to the third 
device, and so on. Start the chain at the device that is the 
farthest from the common grounding point. End the chain by 
connecting the last device to the common grounding point, 
which is connected to the ground of the recording device.

• Free-Floating: In addition to using one of the grounding 
techniques described earlier, plug all devices powered by alter-
nating current (AC), like illuminators, amplifiers, and recording 
units to power outlets using three-two prong adapters.

High Frequency Noise
High frequency noise can also be a problem when 

recording bioelectric potentials. This type of noise is 
seen as the thickening of the recorded line. This noise 
contains many frequencies, and the amplitude of the 
noise is proportional to the resistance of the electrode. 
Therefore, intracellular electrodes, with high resistances, 
pick up a greater amplitude of high frequency noise than 
extracellular electrodes, with low resistances.

Mechanical Noise
Mechanical noise, like vibrations from the ventilation 

system in the room, can cause the electrodes to vibrate 
and produce voltage changes with each vibration cycle. 
To alleviate this problem, isolate the platform holding the 
preparation with foam pads or bicycle inner tubes. Also, 
avoid bumping the table when the recording electrodes 
are in place.

Grounding
When the Model 3000 extracellular amplifier and 

Model 3100 intracellular electrometer are used on the 
same preparation, a common ground electrode should 
be used for the two amplifiers.

Warning: The driven shield of the Model 3000 input cable 
should not be connected to any electrode when an Model 
3100 is used on the same preparation. If the driven shield 
of the Model =3000 is connected to an electrode that is in 
the same bath solution as the ground electrode of the 
Model 3100, the driven shield is connected to ground 
which is a condition that should not exist.

1 The recording circuit of the Model 3100 intracellular 
electrometer has only one grounding point. Place the 
reference electrode in the bath solution of the preparation. 
Plug the cable of the reference electrode into the GND input 
on the front panel of the Model 3100.

2 Place a cable between the ground input of the Model 3100 
and the ground input of the Model 3000 to complete the 
connection of the ground electrode to the Model 3000.

Signal Improvement
1 To improve recordings of the compound action and synaptic 

potentials, move the prep dish away from sources of 60Hz 
noise. These sources include outlets, computers, monitors, 
lights, refrigerators, water baths, and other AC powered 
devices.

2 If the recording still contains a great deal of electrical noise, 
apply the digital filtering function to the data. Click on the 
add function button in the upper margin of the Nerve 
Action Potential channel. Select Filter from the menu of 
computed functions.

3 In the Filter Setup Dialog window, the Filter Mode is set 
to the Hamming Window and the Filter Order is set to 51. 
These are the default settings that should be used.

4 Set the Low Cutoff filter value to 65 and the High Cutoff 
filter value to 8000. The values for the filter cutoffs can be 
set by:

• Typing the values for the filter cutoffs in the boxes to the right 
of the names of the filter cutoffs.

• Clicking on the up or down arrows to the right of the boxes 
displaying the values of the filter cutoffs.

• Clicking on the margins of the colored area in the graphic 
display of the filter and dragging the margins to the values 
required.

Dissection
1 Immerse a crayfish in ice water for 10 minutes, to 

anesthetize it. When the crayfish is fully limp, quickly pith it.

2 Separate the tail (abdominal segments) from the thorax. 
These techniques will be demonstrated in the laboratory. 

3 Securely pin the abdomen on its back in a wax-filled 
chamber. Cover the preparation with cold crayfish saline. 
Cut off the swimmerets which are the paired appendages on 
the ventral surface of each segment. The movements of the 
swimmerets interfere with the recordings if they are not 
removed. 
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4 With sturdy scissors, make a midline incision along the 
ventral surface, starting at the cut end (abdominal segment 
1) and continuing to the most posterior end (segment 6).

Warning: Lift up the tissue with the tips of the scissors to 
avoid damaging the underlying nerve cord and muscles.

5 Cut through both the stout ribs (sternites) and the leathery 
ventral membrane tissue in between the ribs.

6 Make two more incisions, each one a few millimeters to 
either side of the midline. Remove the loose tissue. This will 
expose the ventral nerve cord, including the ganglia, the 
connectives running between the ganglia, and the three 
nerves (I, II, and III) coming out of each side of each 
ganglia. 

7 The slow flexor muscles should be visible to the side of the 
opening made to expose the ventral nerve cord. These 
muscles are attached to the cuticle on the ventral 
membrane in each segment of the tail. Each segment of 
cuticle is nearly 1 cm long and starts about a third of the 
way back from sternite and ends at the following sternite.

8 Remove the ventral membrane that covers the tail from the 
posterior of the cuticle to the following sternite to create a 
window that exposes the slow flexor muscle as well as the 
superficial branch of the third nerve (SBIII) that innervates 
slow flexor muscle. 

Microelectrode Preparation
1 Fill a glass microelectrode with 3M KCl using a fine syringe 

needle (Hamilton type) on a 3cc syringe. 

• The microelectrode is filled from the back. Gently lower the 
needle into the lumen of the microelectrode until the tip of the 
needle is close to the taper in the microelectrode. 

• As you slowly inject the 3M KCl into the microelectrode, pull 
the needle up the microelectrode to allow space for the fluid. 
Keep the tip of the needle under the meniscus of the fluid as 
you withdraw the needle from the microelectrode. This will 
prevent bubbles from forming in the microelectrode.

• Make sure the microelectrode is filled to the top to prevent 
bubbles when it is put in the microelectrode holder.

2 Fill the microelectrode holder with the same 3M KCl solution 
used for the microelectrode. This solution completes the 
electrical connection between the glass microelectrode and 
the intracellular probe. Make sure the gold-plated socket 
(pin jack) on the back of the plastic microelectrode holder is 
screwed tightly into the holder. If the pin jack is loose, the 
3M KCl solution can leak out of the electrode holder and 
make contact with both the pin jack and the pin of the intrac-
ellular probe. If the different metals used to make the pin 
jack, the pin on the intracellular probe, and the pellet or wire 
in the electrode holder are all in contact with 3M KCl, then, 
reactions can take place among the different metals. These 
reactions can cause an off-scale shift in the baseline of the 
recording.

3 If you are using an microelectrode holder with a silver wire 
in place of a Ag-AgCl pellet, the holder does not need to be 
filled with 3M KCl. However, the pin jack needs to be 
screwed tightly into the holder. In this type of holder, the 
silver wire goes into the back of the glass microelectrode 
and makes contact with the solution in the microelectrode. 
This electrolyte can migrate up the wire and into the back of 
the holder. If the pin jack on the holder is loose, the 3M KCl 
can move past the rubber gasket, that normally seals the 
lumen of the holder from the gold-plated socket, and create 
the same problems mentioned in Step 2.

4 If you are using a microelectrode holder with a Ag-AgCl 
pellet, fill the holder with 3M KCl. 

• Loosen the plastic cap of the microelectrode holder to take 
pressure off the rubber gasket behind the cap.

• Gently lower the needle of the filling syringe into the lumen of 
the cap, through the gasket, and into the lumen of the holder 
until the tip of the needle is close to the Ag-AgCl pellet.

• Fill the microelectrode holder with 3M KCl, until a drop forms 
on top of the cap.

Note: Pushing the glass microelectrode into the holder too 
vigorously, or while the cap is tight, may result in the microelec-
trode breaking.

• Place the back of the microelectrode into the lumen of the 
cap. Carefully push the microelectrode through the rubber 
gasket that sits behind the cap, and into the lumen of the 
microelectrode holder. The lumen of the microelectrode holder 
steps down to a smaller diameter, so the back of the glass 
microelectrode will stop on the edge of this smaller lumen.

• Gently tighten the cap of the holder. Tightening the cap too 
much will crack the glass microelectrode.

5 Push the microelectrode holder into the socket of the 
headstage probe.

6 Carefully position the microelectrode tip over the prepa-
ration.

7 Use the micromanipulator's vertical controls to move the 
microelectrode until its tip is in the saline overlying the 
preparation.

8 To complete the circuit, a ground electrode needs to be 
attached to the ground (GND) input of the Model 3100. The 
best material for the indifferent electrode is a coil of Ag-AgCl 
wire. Place the coil of wire in the bath solution surrounding 
the crayfish tail. Make sure no other metal, only the Ag-AgCl 
coil is in contact with saline solution.

9 Check that both electrodes are in the crayfish saline in the 
prep dish.

10 Test the resistance of the microelectrode before impaling 
the muscle fiber. 

• Type Electrode Test in the Mark box to the right of the Mark 
button.

• Click Record to begin recording. Press the Enter key on the 
keyboard to mark the recording.



• Use the ΩTEST switch on the Model 3100 amplifier to send 
a pulse through the microelectrode to test its resistance. 
Examine the recording to determine the pulse voltage recorded 
and the resistance of the microelectrode.

Note: The resistance should be between 10 and 20 MΩ. If the 
resistance is not within this range, replace the microelectrode 
with a new one.

11 Click Stop to halt the recording.The trace on the screen 
may have a small wave or ripple through it. This is noise 
from devices in the room that operate on 60Hz AC current. 
The probe is picking up these currents, but they can be 
reduced by grounding metal objects like the microscope or 
light source to any grounded point on the iWorx unit. 
Turning off and unplugging the light source, when not 
needed also reduces this noise. 

Exercise 1: Spontaneous Synaptic Potentials
Aim: To record spontaneous synaptic potentials from 

the fibers of a slow flexor muscle (SFM).

Procedure
1 Look through the microscope as you use the controls of the 

micromanipulator to move the tip of the microelectrode over 
a bundle of muscle fibers. Position the tip above a healthy-
looking fiber.

Note: Unhealthy fibers are opaque, beaded, or twitching.

2 Type SFM Fiber 1 in the Mark box to the right of the Mark 
button.

3 Click Record to begin recording.

4 Once the tip of the microelectrode is close to the membrane 
of a healthy muscle fiber, watch the recording of the 
membrane potential on the computer screen. When the 
microelectrode tip touches a muscle fiber membrane, a 
small deflection of the recording, either up or down, may 
occur. 

5 Penetrate the membrane of the muscle fiber by either:

• Pushing the microelectrode tip through the membrane using 
the controls of the micromanipulator; or,

• Gently tapping the base of the micromanipulator to create a 
small amount of vibration in the microelectrode tip, which will 
aid in the penetration of the membrane.

Warning: Do not lower the tip into the muscle fiber more 
than is necessary to avoid breaking the tip

6 As the tip of the microelectrode penetrates the membrane, 
the recording displayed on the computer screen deflects 
downward rapidly. When this happens, stop moving the 
electrode! The tip of the microelectrode is inside the 

muscle fiber. 

Note: Sometimes, the initial drop in voltage will not be will be 
abrupt. The voltage may drift down to a lower level as the 
tissue seals around the tip of the electrode. Count this more 
negative value as the resting potential, if it is at a steady level.

7 Click AutoScale to view the voltage levels before and after 
the microelectrode penetrated the membrane.

8 Repeat Steps 5 through 10 to record the resting membrane 
potentials from nine additional muscle fibers. Check the 
resistance of the electrode frequently; a low resistance 
means that the tip is broken and it will damage the muscle 
fibers. 

9 Click Stop to halt recording.

10 Select Save in the File menu.

Analysis
1 Scroll through the data file and locate the section of the 

recording made when the microelectrode penetrated the 
muscle fiber membrane.

2 Use the Display Time icons to adjust the Display Time of 
the Main window to display a fifteen-second section of the 
recording when the microelectrode penetrated the 
membrane on the Main window. This section of data can 
also be selected by:

• Placing the cursors on either side of the fifteen-second 
section of the recording, and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar (Figure NB-4-5 on page NB-4-4) to expand 
or contract the fifteen-second recording to the width of the 
Main window.

3 Click on the Analysis window icon in the toolbar (Figure 
NB-4-5 on page NB-4-4) or select Analysis from the 
Windows menu to transfer the data displayed in the Main 
window to the Analysis window.

4 Look at the Function Table that is above the Membrane 
Potential channel in the Analysis window. The mathe-
matical functions, V2-V1 and T2-T1, should appear in this 
table. The values for V2-V1 and T2-T1 are displayed in the 
table across the top margin of the Membrane Potential 
channel.

5 Once the cursors are placed in the correct positions for 
determining the change in voltage (V2-V1) as the tip of the 
microeletrode enters the muscle fiber, the value for V2-V1 
can be recorded in the on-line notebook of LabScribe by 
typing the names and values of the parameters directly into 
the Journal.

6 The functions in the channel menu of the Analysis 
window can also be used to enter the name and value of 
the voltage change from the recording to the Journal. To 
use these functions:

• Place the cursors at the locations used to measure the 
membrane potential.
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• Transfer the name of the parameter to the Journal using the 
Add Title to Journal function in the Membrane Potential 
channel menu.

• Transfer the value for the parameter to the Journal using the 
Add Ch. Data to Journal function in the Membrane Potential 
channel menu.

7 On the Membrane Potential channel displayed in the 
Analysis window, use the mouse to click on and drag a 
cursor to the baseline recorded before the microelectrode 
penetrated the fiber. Drag the other cursor to the voltage 
level that results from the microelectrode being in the fiber.

8 Record the value for the voltage change (V2-V1) in the 
Journal using the one of the techniques described in Steps 
5 or 6, and in Table NB-4-4 on page NB-4-8.

9 Divide the value for V2-V1 by the gain of the Model 3100 
electrometer to obtain the membrane potential. For 
example, a voltage difference (V2-V1) of 320 millivolts 
recorded by the Model 3100 with a gain of 10X is equal to a 
membrane potential of 32 millivolts:

320 millivolts/10X Gain = 32 millivolts

10 Place a section data recorded while the microelectrode was 
in a fiber on the Main window.

11 Use the AutoScale and the Display Time functions to 
zoom-in on the voltage recorded while the microelectrode 
was in the fiber. 

12 Examine this section of the recording to determine if any 
synaptic potentials are present. These potentials usually 
have actual amplitudes of 5mV or less.

Questions
1 What was the range of values measured for the resting 

membrane potentials of the fibers? 

2 Do some of the values fall outside the range of the mean + 
2 Standard Deviations (S.D.)?

3 Why do resting membrane potentials recorded from 
different fibers vary?

4 Can lower values for the membrane potentials be attributed 
to the state of health of the muscles or the ease at which the 
fibers were penetrated? 

Exercise 2: Action Potentials in Motor Neurons
Aim: To record motor nerve action potentials from the 

SBIII nerve.

Procedure
1 Turn on the Model 3000 amplifier. Make sure it has warmed 

up for five minutes before it is used for the recording.

2 Use the second micromanipulator to position the tip of the 
suction electrode near the SBIII nerve of the slow flexor 
muscle fibers from which the membrane potentials were 
recorded. 

3 Check the size of the tip of the suction electrode. It should 
be the same size or only slightly larger than the diameter of 
the nerve.

4 Without moving the tubing, pull back on the plunger of the 
syringe, that is connected to the tubing of the suction 
electrode, to pull the end, or a loop, of the nerve into the 
suction electrode. 

5 Turn on the audio monitor connected to the output of the 
Model 3000 amplifier. The action potentials in the motor 
neurons should be heard as a series of clicks.

6 Type Motor Neuron in the Mark box to the right of the 
Mark button.

7 Click Record to begin recording.

8 To improve the display of the action potentials in the SBIII 
nerve on the Main window:

• Increase the gain of the Model 3000 amplifier.

• Minimize the 60 Hz noise by using the filters of the amplifier 
and the digital filters of the LabScribe2 software.

9 If the spontaneous rate of firing from the motor neurons is 
too slow, brush the sensory hairs on the lateral edge of the 
same or adjacent tail segments to increase the firing 
frequency.

10 Continue to record for two minutes.

11 If only two or three different types of action potentials are 
detected, use a suction electrode with a smaller tip or 
record from a different SBIII nerve.

12 Click Stop to halt recording.

13 Select Save in the File menu.

Table NB-4-4: Resting Membrane Potentials (Em) 
of Slow Flexor Muscle Fibers.

Voltage Change (∆V) 
Recorded, in mV

∆V/Gain = Em, in mV

Fiber 1

Fiber 2

Fiber 3

Fiber 4

Fiber 5

Fiber 6

Fiber 7

Fiber 8

Fiber 9

Fiber 10

Mean
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Analysis
1 Measure and record the parameters of the action potentials 

doming from the neurons of the SBIII nerve using the 
techniques described in Exercise 2.

2 Inspect the recording made from the SBIII nerve to 
determine the number of different types of action potentials 
present. Use these parameters to distinguish the different 
types of action potentials recorded from the SBIII nerve:

• Amplitude (Amp): Measure the amplitude of an action 
potential by placing one cursor on the baseline before the 
action potential, and the second cursor on the peak of the 
potential. The value for the V2-V1 function on the Nerve 
Action Potential channel is the amplitude.

• Duration (Dur): Measure the duration of an action potential 
by placing one cursor at the onset of the action potential, and 
the second cursor on the point where the potential returns to 
the baseline. The value for the T2-T1 function on the Nerve 
Action Potential channel is the duration.

• Rise Time (Rise): Measure the rise time of an action 
potential by placing one cursor at the onset of the action 
potential, and the second cursor on the peak of the potential. 
The value for the T2-T1 function on the Nerve Action 
Potential channel is the rise time.

• Fall Time (Fall): Measure the fall time of an action potential 
by placing one cursor on the peak of the potential, and the 
second cursor on the point where the potential returns to the 
baseline. The value for the T2-T1 function on the Nerve 
Action Potential channel is the fall time.

• Frequency (Freq.): Measure the frequency of a type of 
action potential by placing one cursor on the peak of an action 
potential, and the second cursor on the peak of the successive 
potential. The value for the T2-T1 function on the Nerve 
Action Potential channel is the period of the wave type. The 
inverse of the period is the frequency.

• Polarity (Pol.): note whether the waveform of the action 
potentials goes up (positive) or down (negative) on the screen.

3 Enter information about the types of action potentials 
recorded in the Journal and Figure NB-4-5 on page NB-4-
9.

Question
1 How many different types of action potentials did you 

detect?

2 What membrane properties affect the shape and size of 
action potentials?

Exercise 3: Action and Synaptic Potentials
Aim: To correlate the activity of action potentials in the 

SBIII nerve with the activity of synaptic potentials in the 
muscle fibers.

Procedure
1 With the suction electrode attached to the SBIII nerve and a 

microelectrode placed in the membrane of a slow flexor 
muscle fiber, record the presynaptic action potentials and 
the postsynaptic membrane potentials at the same time.

2 Record form several muscle fibers since most muscle fibers 
are not innervated by every motor neuron. The synaptic 
potentials from a particular muscle fiber are usually the 
same size and shape every time an action potential from a 
particular motor neuron occurs.

Questions
1 Is one particular type of nerve action potential associated 

more closely with postsynaptic potentials more than any 
other type of action potential?

2 Are particular types of action potentials associated with 
particular sizes of postsynaptic potentials? For example, are 
the largest action potentials always followed by largest 
excitatory post synaptic potentials (EPSP) or by the 
smallest EPSPs?

3 At least one of the motor neurons in the SBIII nerve is inhib-
itory. Can you tell which type of action potential from the 
SBIII nerve produces inhibitory postsynaptic potentials 
(IPSP)? Does this type of nerve action potential produce 
IPSPs in all muscle fibers?

Exercise 4: Evoked Synaptic Potentials
Aim: To evoke and record postsynaptic potentials in 

slow flexor muscle fibers while stimulating the SBIII 
nerve.

Procedure
1 If it has not already been done, cut the SBIII nerve at the 

point where this nerve enters the ventral nerve cord. Pull 
the cut end of the nerve into the tip of the suction electrode 
by pulling back on the syringe attached to the end of the 
suction tubing.

2 Locate the C-STIM-BNC-P2 BNC stimulator cable and 
double male banana-female BNC adapter in the NBK-214 
kit.

3 Plug the male double banana-female BNC adapter into the 
positive (red) and negative (black) banana jacks of the IWX/
214 stimulator The banana plug that goes into the negative 
(black) stimulator output is identified by a tab, embossed 
with the letters GND (ground), on that side of the adapter 

4 Attach the BNC connector of the C-STIM-BNC-P2 stimu-
lator cable to the adapter on the stimulator outputs

Table NB-4-5: Properties of Action Potentials 
Recorded from SBII I  Nerve.

AP Type Amp.
(mV)

Dur.  
(msec)

Rise 
(msec)

Fal l
(msec)

Freq. 
(Hz)

Pol .
+,  -

1

2

3

4

5

6

7

iWorx Neurobiology Lab Manual NB-4-9



5 Connect the lead wire for the electrode inside the lumen of 
the suction electrode to the red pin connector of the C-
STIM-BNC-P2 stimulator cable. Connect the lead wire for 
the electrode wrapped the tip of the suction electrode to the 
black pin connector of the C-STIM-BNC-P2 stimulator 
cable.

6 Pull down the Settings menu. Select the SynapticPoten-
tials-B-NBK settings file. The LabScribe Main window 
appears on the computer screen as configured by settings 
in the Channels and Stimulator Preferences Dialog 
windows. The settings, which can be viewed by selecting 
Preferences from the Edit menu on the LabScribe Main 
windowb, are listed in Table NB-4-6 on page NB-4-10 and 
Table NB-4-7 on page NB-4-10.

7 Click the Stimulator Preferences icon on the LabScribe 
toolbar (Figure NB-4-5 on page NB-4-4) to open the stimu-
lator control panel on the Main window.

8 Check the settings on the stimulator control panel against 
the settings for this portion of the exercise that are listed in 
Table NB-4-7 on page NB-4-10. To make changes to the 
stimulus parameters:

• Click on the arrow buttons to the right of the window that 
displays the value of the parameter to increase or decrease the 
value; or, 

• Type the value of the parameter in the window next to the 
label of the parameter.

• Click the Apply button to effect the change to the stimulator.

9 Click the Record button to stimulate the SBIII nerve and 
record from the postsynaptic slow flexor muscle fiber.

10 If a response did not occur in the muscle fiber as recorded 
on the Membrane Potential channel, increase the stimulus 
amplitude. Remember to click the Apply button to finalize 
changes.

11 Continue to increase the stimulus amplitude until a synaptic 
potential occurs. Note the amplitude at which this potential 

occurred.

12 Continue to increase the stimulus amplitude and record the 
response of the fiber. As the stimulus amplitude is 
increased, the amplitude of the synaptic potential will 
increase in a stepwise manner. These steps correspond to 
activation of different axons in the nerve.

Questions
1 At what stimulus amplitude did the muscle fiber first 

generate a synaptic potential?

2 At what stimulus amplitude did the amplitude of the synaptic 
potential reach a maximum level?

3 How many times larger is the stimulus that delivered the 
maximum response than the stimulus that delivered the first 
measurable synaptic potential?

Appendix

Table NB-4-6: Settings on the Channel Window 
of the Preferences Dialog Used to Configure the 
iWorx Recording System for Exercise 4.

Parameter Uni ts/Ti t le Sett ing Mode/
Function

Acquis i t ion Mode Scope Mult ip le

Sweeps Number 1

Delay between 
Sweeps Sec 0.000

Start User

Stop Sec Timed -  0.020

Display Time Sec 0.020

Speed Samples/Sec 10000

Channel  A2 Synapt ic Potent ia ls S BNC

Channel  S1 St imulus S Record

Table NB-4-7: Settings on the Stimulator 
Window of the Preferences Dialog that Configure 
the iWorx System for Exercise 4.

Parameter Uni ts/Ti t le Sett ing

St imulus Mode Pulse

St imulator Start With Recording

Time Resolut ion msec 0.01

Toolbar Step Frequency Hz 1

Toolbar Step Ampl i tude Volts 0.01

Toolbar Step Time Variable 0.01

Delay Sec 0.002

Ampl i tude (Amp) Vol t 0.010

Pulses (#pulses) Number 1

Pulse Width (W) msec 0.1

Time Off  (T Off) msec 0.9

Time Off  Ampl i tude Volts 0

Holding Potent ia l  (HP) Vol ts 0

Table NB-3-8: Recipe for Crayfish Saline 
Solution.

Concentrat ion
(mMolar) Salt

Grams/Liter
DI H20

205.34 Sodium Chlor ide 12.00

5.36 Potassium Chlor ide 0.40

13.43 Calc ium Chlor ide∗2H2O 1.97

2.61 MgCl2.6H2O 0.53

9.99 Tr is 1.21

Adjust  pH to 7.4 wi th 6N HCl
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